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ABSTRACT 

Traffic is now a growing concern in most cities around the world. Inadequate traffic control 

wastes time and energy and causes harmful carbon emissions, road accidents and many 

economic problems. This thesis focuses on a cooperative traffic control framework to 

optimize travel time for better uniform traffic flow across multiple sections of Mirpur Road. 

To reach the target, we first select three segments from Mirpur Road. The number of vehicles 

up and down in each section will be calculated for the three scheduled times of the day. We 

need to count traffic to get a better picture of the traffic scene. We will then convert the 

calculated data into a PCU (passenger car unit) based on a standard reference. We will 

determine the capacity of the road for the selected sections and we will also determine the 

saturation flow for the selected intersections. Lastly, a comparison will be made between our 

roadway capacity and saturation flow. Then compare the output which will help to represent 

the current traffic conditions of the Mirpur road. However, while data computation may not 

be decent enough to illustrate the actual situation, it may be helpful to have a true scale of 

information to help traffic computation lead to digitalization. Thus, in future studies this 

approach can be used to determine the method of automation of the traffic signals. 
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CHAPTER 1 

INTRODUCTION 

 

1.1 Introduction: 

As the number of vehicles worldwide increases and the need for mobility increases, the 

frequency and duration of traffic jams in large cities increases. High fuel costs and 

environmental concerns provide important incentives to reduce traffic delays. In short, the 

most effective measures to deal with traffic jams seem to be to build new roads- An 

alternative that is often not viable due to lack of space and or budget or due to environmental 

or social needs-and a more efficient use of existing infrastructure and capabilities through the 

management and control of an improved traffic. The dynamic traffic control in an urban setup 

has always been very attractive to traffic engineers and has been for quite some time. 

 

Urban arterial roads are very attractive to drivers. However, a large number of vehicles 

entering urban arterial roads can cause traffic congestion, or even cause traffic accidents. 

Vehicles on arterial roads need to reduce travel time and number of stops. 

 

The purpose is to get a smooth flow of vehicles on the main arterial roads. Green Wave 

Control is an arterial traffic coordination control system, which combines the traffic signals 

of intersections with arterial roads to match any or less red lights driving at a certain speed. In 

other words, the traffic signals at adjacent intersections turn green at a given time sequence, 

like a rotating "green wave" 

 

1.2    Problem Definition: 

Dhaka, the capital of Bangladesh, is one of the most thickly populated urban communities on 

the planet. Twelve million people live in the city of Bangladesh. The numbers are increasing 

day by day and most of the traffic is badly affected by the huge traffic jam. Defective traffic 

signaling systems, inadequate manpower, narrow roads and overtaking tendencies of drivers 

create long-haul traffic. Due to traffic, most of the working hours have to be left on the roads 

which indirectly adversely affect the economy. It causes severe air pollution and noise 

pollution and it worsens the overall environmental conditions. 
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1.3  Objectives of the Research 

 

 The objectives of the study are as follows: 

 Study of complex heterogeneous traffic. 

 Measurement of roadway capacity for different links. 

 Measurement of saturation flow of particular links. 

 Comparison between roadway capacity and saturation flow by ArcGIS. 

 

1.4 Scope: 

 

 The scopes of this research are: 

 

 The main purpose of this research is to analyze Hourly PCU variation and the 

comparison between roadway capacity and saturation flow from collected traffic 

Data. 
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    CHAPTER 2 

    LITERATURE REVIEW 

 

2.1 Introduction: 

Every day, millions of people experience traffic congestion. Especially in contemporary 

cities, people are often stuck in traffic jams for a few minutes, thus wasting considerable time 

and money. Traffic delays can result in the loss of health of drivers and high risk of road 

accidents. Also, the environment is affected because vehicles emit huge amounts of harmful 

carbon, causing severe global warming. 

 

2.2 Literature Review: 

An analysis by NASA revealed that the global surface temperatures in 2012, which caused 

numerous concerns such as a rise in sea level, decrease in snow cover, and decline in sea-ice 

extent, were the ninth warmest on record [1]. In addition, the European Commission stated 

that road transportation contributes to approximately one-fifth of the total CO2 emissions in 

Europe [2]. Light-duty vehicles (i.e., cars and vans) are the major source producing 

approximately 15% of CO2 emissions in Europe. In addition to harming humans and the 

environment, traffic congestion affects the economy. The Toronto Board of Trade stated that 

economic loss in the Toronto region caused by traffic congestion is $6 billion a year and will 

increase to $15 billion by 2031 [3]. Therefore, efficient traffic management is urgently 

required for relieving traffic congestion by enabling vehicles to cross intersections as quickly 

as possible. The waiting and travel time of drivers and greenhouse gas emissions produced 

from transportation must be further reduced. Traditional traffic control employs fixed-time 

signal control and thus cannot dynamically meet current traffic. 

 

Demands [4]. Traffic congestion is caused when traffic flows differ from typical 

circumstances. Consequently, adaptive signal control [5], such as split cycle offset 

optimization technique (SCOOT) [6] and Sydney coordinated adaptive traffic system 

(SCATS) [7], has been proposed for solving the ineffective control problem by using real-

time traffic information to determine how signals should be scheduled. Real-time traffic 

information is generally collected by dedicated detectors, such as induction loops [8], [9], 
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magnetic sensors, and video cameras [10], [11], to obtain the number of vehicles approaching 

or exiting an intersection. 

 

Traditional fixed-time traffic control cannot dynamically meet current traffic demands. Here 

through this research, we can learn about the status of traffic jams of 3 Links of Mirpur road 

by compared ArcGIS Application. Based on the result of our exploration we will bring 

forward some points of consideration to alleviate the current problems for particular links. 
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                                      CHAPTER 3 

METHODOLOGY 

3.1 Introduction: 

This chapter of the thesis deals with the method that has been applied in preceding with the 

thesis objectives. The chapter discusses the questions that were raised during performance of 

the study. The chapter also provides an overview of the research approach and explanation of 

specific terms that were used reaching the study goals. In determining the a representation of 

the congestion situation Including Saturation flow analysis adjacent to Daffodil International 

University a proper method of attack needs to be selected. An appropriate way of proceeding 

to the study leads to success in a steady way while an approach without good guidance leads 

to wondering around. This chapter takes an attempt to show how the thesis work was 

proceeding and the reason behind following those ways. 

3.2 Flow chart of methodology: 

 

 

                                               Fig: 3.1 Methodology flow chart 
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3.3 Data Collection: 

Several links are selected in Dhaka city, for the analysis. The links are selected from Mirpur 

Road. Those links are Dhanmondi-32 to Shukrabad, Shukrabad to Dhanmondi-27, and 

Dhanmondi-27 to Manik Mia Ave. In our scheduled links, its vehicles make the most of these 

three days on Monday, Wednesday, Thursday .So we collect these three days of data a week. 

We have no data for these days, so there is a public holiday on Friday, Saturday; New-market 

is closed on Tuesday. We count the traffic volume data for each link for 7 days. We calculate 

the traffic volume for each link by dividing it into three spells per day. Spells are from at 

Morning Peak hour (9 AM to 11 AM), at off Peak hour (1 PM to 3 PM) and at Peak hour (5 

PM to 7 PM). We used stopwatch, Hand Note, Pen, Mobile camera for this operation. We 

collect day wise data and links wise data. We collect the data and then input it into Microsoft 

Excel. 

 

 
 

 

 

Fig 3.2: Picture at Mirpur Road 

Here,  

Upward Direction: → Dhanmondi-32, → Shukrabad, → Dhanmondi-27, → Manik Mia 

Avenue  

Downward Direction: →Manik Mia Avenue, →Dhanmondi-27, →Shukrabad, 

→Dhanmondi- 
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Direction 

Date    Bus Covered Van Private car CNG Motor-cycle 

    (2hr) (2hr) (2hr) (2hr) (2hr) 

Day 1 Peak      

  Off-Peak      

  Peak      

Day 2 Peak      

 Off-Peak      

 Peak      

Day 3 Peak      

 Off-Peak      

 Peak      

Day 4 Peak      

 Off-Peak      

 Peak      

Day  5 Peak      

 Off-Peak      

 Peak      

Day  6 Peak      

  Off-Peak      

  Peak      

Day 7 Peak      

  Off-Peak      

  Peak      

 

Table: 3.1 7 days data collection table 

 

3.4 Uniform Traffic Count: 

We calculate PCU from the traffic volume data. Then we multiply the hourly peak, off peak 

vehicle with the PCU factor and calculate the PCU/hr. for each spell for Bus, Covered van, 

Private Car, CNG and Motor-cycle. 

Vehicle Type Passenger Car Unit (PCU) Value 

BUS 3 

COVERED VAN 2 

PRIVATE CAR 1 

CNG 0.75 

MOTOR-CYCLE 0.5 

Table: 3.2 Passenger Car Unit (PCU) Value 
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3.5 Determine of Roadway Capacity: 

  

First we calculated the road capacity of our assigned links. To calculate the roadway capacity 

of link -1, measures the three widths at the beginning and the middle at the end of link. Then 

find the smallest width from all width. Then we measured Shoulder width. Then find out to 

calculate the average speed of the vehicle. We consider the vehicle into two categories, 

Category-1 (Bus, Private car, Covered van) and Category-2 (CNG, Motor-cycle) 

To find out the average speed of category-1, let‟s find average time to go 100m for three 

buses. In the same way we calculate the average time to go stop 100m of three private cars 

and three covered van by a stopwatch. Then take the average time of the bus private car, 

covered van divided by three. Then convert the meters to kilometers and second to hour. 

Thus, we first calculate the average speed for category-1 vehicles. For the category-2 of the 

vehicle, let‟s first calculate the average time to go 100m on three CNG and three Motor-

cycles. To find the average time divided by two. Similarly, calculate the average speed for the 

category-2 vehicles by converting meters to kilometers per hour. Then we calculate the 

passing sight distance from the recommended table for the category-1 and category-2 

vehicles. Using all the above data, we calculate roadway capacity for the category-1 and 

category-2 by using recommended manual. Then add the roadway capacity for the category-1 

and category-2 vehicles and calculate the total capacity of the link-1. Similarly we find out 

the total capacity for link-2 and link-3. 

 Link       

1 Roadway pattern=     

2 Lane width=     

3 Shoulder condition=     

4 Operating speed=     

5 
%Passing sight 

distance= 
    

6 Level of service=     

Solution :       

Capacity of 3 lane 2 way=   veh/hr 

Capacity reduction factor for 9 feet width=     

Capacity reduction for 1 feet shoulder=     

Therefore actual roadway capacity=   passenger(veh/hr) 

Table: 3.3 determined roadway capacity 
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3.6 Determine of Saturation flow: 

 

First we select intersection for our selected links. Then we took cycle time and Green + 

Amber period. We count vehicles 6 sec interval. We took data 3.5 meters distance from stop 

line. We started counting when the green signal starts. In six second interval vehicle count 

recorded on the given form Table. When a vehicle‟s rear wheel crosses the stop line then the 

count included. We continue keep counting when saturation flow level goes on. We 

discontinue counting when the flow no longer saturation level. Our counting stopped at the 

end of ember period and we count any vehicle crossing on the red period in the last interval. 

We repeated vehicle count for six cycles. Then we convert vehicles in terms of PCU values 

for every interval Table. Then we determined average PCU for each interval. Then we 

convert PCU/hour from 6 second average PCU. We collected data in Monday, Wednesday, 

Thursday and time peak hour (9 am to 11 am) and off peak hour (1 pm to 3 pm). 

 

 
 

Table: 3.4 Saturation flow data sheet 
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3.7 Polygon line Drawing Step: 

 

We prepared (.xls) file for our all data. We set up format by LINE, XSTART, YSTART, 

XEND, YEND, Point, HourlyPCU and Time_stamp for hourly PCU video simulation in 

ArcGIS. Similarly we set up format by LINE, XSTART, YSTART, XEND, YEND, Point, 

Time_stamp, Road_capacity and Saturation_flow for comparison between roadway capacity 

and saturation flow video simulation in ArcGIS. 

 

For hourly PCU video simulation process: 

 

Step 01:  

Select→ Add Data → Select map 

 

Step 02:  

Select →Add Data → Select the Excel File (.xls) 

 

Step 03: 

Catalog→ System Toolboxes→ Data Management Tools→ Features→ XY to line. 

 

Step 04: 

Input Line (Here, Select the Excel File(.xls)→ Start X Field (Here, Select X Start)→ Start Y 

Field (Here, Select Y Start)→ End X Field (Here, Select X End)→End Y Field (Here, Select 

Y End)→ Line Type (Here, Select RHUMB_LINE)→ Spatial Reference Properties (Here, 

Select Asia → Everest – Bangladesh) → Ok 

 

Step 05: 

Select Layer→ Layer properties →Time→ Enable time on this layer→ time filed→ 

Time_stamp→ time step interval→ 3 days → click calculate→ time zone→ Dhaka→ 

Apply→ ok. 

 

Step 06: 

          Select Layer→ Layer properties→ Symbology→ Quantities→ graded colors→                           

values→ select hourly PCU→ Classes→ Select 6→ Apply→ ok 
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Step 07: 

Select time slider→ option→ time display→ time zone→ Dhaka→ time step interval→ 3 

days→ time windows → 4 days→ time extent→ restrict full time extent to→ select layer→ 

ok. 

 

Step: 8 

Run the video simulation and export. 

 

For roadway capacity and saturation flow comparison video simulation process: 

 

Similarly hourly PCU video simulation just step-06 will be changed. 

     

Step 06: 

          Select Layer→ Layer properties→ Symbology→ chart→ graded colors→                           

values→ select roadway capacity and saturation flow data → graded colors→ Apply→ ok 

 

 

 

Table: 3.5 ArcGIS Hourly PCU „.xls‟ format 

 

 

 

Table: 3.6 ArcGIS Roadway capacity & Saturation flow „.xls‟ format 

 

 

 

 

LINE XSTART YSTART XEND YEND Point HourlyPCU Time_stamp

1

2

3

4

5

LINE XSTART YSTART XEND YEND Point Time_stamp Road_capacity Saturation_flow

1

2

3

4

5



Page | 12  

©Daffodil International University 

 

CHAPTER 4 

ROADWAY CAPACITY AND SATURATION FLOW 

 

4.1 Introduction: 

 

The capacity of a roadway is its ability to collected traffic. It is usually represent as the 

number of vehicles that can pass a given point in a certain time at a given speed. Of course 

roadways are not ideal and prevailing roadway and traffic conditions those reduce ability of a 

road to collected traffic must be taken into consideration in roadway capacity estimation. In 

determining roadway capacities for uninterrupted flow conditions the general procedure, 

described below, is to apply appropriate empirically based adjustments for prevailing 

roadway and traffic conditions. The limit of a given link of roadway expressed either as 

unidirectional or the two headings for a two path or three path roadways might be 

characterized as greatest number of vehicle that has a sensible desire for ignoring a given 

connection of roadway during a given timespan under winning roadway and traffic condition. 

While the most extreme number of vehicles that can be gathered stays fixed under 

comparable roadway and traffic conditions, there is a scope of lesser volumes which can be 

dealt with under varying working conditions. 

 

When the green period at a traffic signal commences vehicles take a few seconds to 

accelerate to normal running speed, but after this initial period the queue discharges at a more 

or less constant rate. This rate is called the saturation flow and is usually expressed in 

vehicles per hour of green time. While the signal is green, vehicles continue to pass through 

the intersection at the saturation rate of flow, subject to the existence of stable queue. Some 

vehicles, but not all, make use of the amber period to cross the intersection and the average 

discharge rate falls to zero toward the end of this period. 

The analysis of data from a typical field data sheet is followed step by step. Passenger Car 

Equivalence of vehicles is given in order to be able to convert the saturation flow to 

passenger car units if the composition of the traffic is known. 
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4.2 Roadway capacity: 

 

We considered two categories vehicles as chapter three methodology. So we determined 

roadway capacity for two categories vehicle. 

   

 Passing sight distance for design of two lane highways: 

 

Table: 4.1 passing sight distance for design of two lane highway. 

 

Link -1 

 

Link name: Dhanmondi-32 to Shukrabad 

Dhanmondhi-32 to Shukrabad link we measured and found three lanes two ways. maximum 

width of the lane was 50 feet and minimum width was 28 feet. We took minimum width 28 

feet. Then we determined operating speed of two categories vehicle. After that we determined 

for two type categories vehicles roadway capacity the selected link.  

 

Fig: 4.1 Link-1 with measurement 
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Category-1(Bus, Private car, Covered van)   

Bus :( 100m to go need time)                             Private car: (100m to go need time)  

Bus-1= 6 sec Private car-1=5 sec 

Bus-2= 7 sec Private car-2=4 sec 

Bus-3= 6 sec Private car-3=6 sec 

Avg= 6 sec Avg=5 sec 

    

Covered van: (100m to go need time)             

Covered van-1=7 sec   

Covered van-2=9 sec   

Covered van-3=5 sec   

Avg=7 sec   

    

Avg time= (7+5+6)/3=6 sec   

 

Category-1(Bus,Private car, Covered van)   

Average= 6 sec 

  

  

Speed= 59 kmph 

  

  

Convert= 37 mph 

  

  

  
 

   

  

Segment-2 for category-1 

   

  

1 
Roadway pattern= 

3 Lane two 

way 

 

  

2 Lane width= 9  feet 

 

  

3 Shoulder condition= 1  feet 

 

  

4 Operating speed= 37 mph 

 

  

5 %Passing sight distance= 16.25 ft 

 

  

6 Level of service= d 

  

  

Solution :           

Capacity of 3 Lane 2 way= 2280 veh/hr   

Capcity reduction factor for 9 feet width= 0.81     

Capcity reduction for 1 feet shoulder= 0.78     

Therefore actual roadway capacity= 1441 passenger(veh/hr)   
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Category-2(CNG, Motor cycle)   

CNG :( 100m to go need time)  Motor cycle :( 100m to go need time)  

CNG-1= 6 sec Motor cycle-1= 5 sec 

CNG-2= 6 sec Motor cycle-2= 6 sec 

CNG-3= 7 sec Motor cycle-3= 4 sec 

Avg= 6 sec Avg= 5 sec                                        

    

  Avg. time= (6+5)/2=6 sec   

 

Category-2(c.n.g,m.c)         

  
 

   

  

Average= 6 sec 

  

  

Speed= 64 kmph 

  

  

Convert 39 mph 

  

  

  
 

   

  

Link-1 for category-2 

   

  

  
 

   

  

1 Roadway pattern= 3 Lane two way 

 

  

2 Lane width= 9  feet 

 

  

3 Shoulder condition= 1  feet 

 

  

4 Operating speed= 39 mph 

 

  

5 %Passing sight distance= 13.56 ft. 

 

  

6 Level of service= d 

  

  

  
 

   

  

Solution :           

        

Capacity of 3 lane 2 way= 3200 veh/hr.   

Capacity reduction factor for 9 feet width= 0.81     

Capacity reduction for 1 feet shoulder= 0.78     

Therefore actual roadway capacity= 2022 Passenger (veh/hr.)   
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Link-2 

Link name: Shukrabad to Dhanmondi-27 

Shukrabad to Dhanmondi-27 link we measured and found three lanes two ways. Maximum 

width of the lane was 51 feet and minimum width was 27 feet. We took minimum width 27 

feet. Then we determined operating speed of two categories vehicle. After that we determined 

for two type categories vehicles roadway capacity the selected link. Sobhanbag mosque 

created bottled neck. So here road is congested. 

 

 

Fig: 4.2 Link-2 with measurement 

 

Category-1(Bus, Private car, Covered van)   

Bus :( 100m to go need time)                             Private car: (100m to go need time)  

Bus-1= 8 sec Private car-1= sec 

Bus-2= 6 sec Private car-2=6 sec 

Bus-3= 5 sec Private car-3=5 sec 

Avg= 6 sec Avg=5 sec 

    

Covered van: (100m to go need time)             

Covered van-1=6 sec   

Covered van-2=8 sec   

Covered van-3=7 sec   

Avg=7 sec   

    

Avg time= (6+5+7)/3=6 sec   
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Category-2(CNG, Motor cycle)   

CNG :( 100m to go need time)  Motor cycle :( 100m to go need time)  

CNG-1= 5 sec Motor cycle-1= 6 sec 

CNG-2= 8 sec Motor cycle-2= 3 sec 

CNG-3= 6 sec Motor cycle-3= 4 sec 

Avg= 6 sec Avg= 4 sec                                        

    

  Avg. time= (6+4)/2=5 sec   

 

Category-1(Bus, Private car, Covered van)   

  
 

   

  

Average= 6 sec 

  

  

Speed= 59 kmph 

  

  

Convert= 37 mph 

  

  

  
 

   

  

Link-2 for category-1 

   

  

  
 

   

  

 

1.Roadway pattern= 3 Lane two way 

 

  

 

2. Lane width= 9  feet 

 

  

 

3. Shoulder condition= 1  feet 

 

  

 

4.Operating speed= 37 mph 

 

  

 

5. %Passing sight  distance= 16.25 Ft. 

 

  

 

6.Level of service= d 

  

  

  
 

   

  

Solution :           

        

Capacity of 3 Lane 2 way= 2280 veh/hr.   

Capacity reduction factor for 9 feet width= 0.81     

Capacity reduction for 1 feet shoulder= 0.78     

Therefore actual roadway capacity= 1441 Passenger (veh/hr.)   
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Category-2(CNG, Motor-Cycle)       

  
 

   

  

Average= 5 sec 

  

  

Speed= 68 kmph 

  

  

Convert= 42 mph 

  

  

  
 

   

  

Link-2 for category-2 

   

  

 
 

   

  

1 Roadway pattern= 3 Lane two way 

 

  

2 Lane width= 9  feet 
 

  

3 Shoulder condition= 1  feet 

 

  

4 Operating speed= 42 mph 

 

  

5 %Passing sight distance= 16.25 Ft. 

 

  

6 Level of service= d 

  

  

  
 

   

  

Solution :           

        

Capacity of 3 Lane 2 way= 3200 veh/hr.   

Capacity reduction factor for 9 feet width= 0.81     

Capacity reduction for 1 feet shoulder= 0.78     

Therefore actual roadway capacity= 2022 Passenger (veh/hr.)   

 

Link-3  

Link name: Dhanmondi-27 to Manik mia  

Dhanmondi-27 to Manik mia link we measured and found three lanes two ways. Maximum 

width of the lane was 51 feet and minimum width was 37 feet. We took minimum width 37 

feet. Then we determined operating speed of two categories vehicle. After that we determined 

for two type categories vehicles roadway capacity the selected link. 
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Fig: 4.3 Link-3 with measurement 

 

Category-1(Bus, Private car, Covered van)   

Bus :( 100m to go need time)                             Private car: (100m to go need time)  

Bus-1= 5 sec Private car-1= 6sec 

Bus-2= 6 sec Private car-2=4 sec 

Bus-3= 4 sec Private car-3=6 sec 

Avg= 5 sec Avg=5 sec 

    

Covered van: (100m to go need time)             

Covered van-1=9 sec   

Covered van-2=6 sec   

Covered van-3=5 sec   

Avg=7 sec   

    

Avg time= (5+5+7)/3=6 sec   

 

Category-2(CNG, Motor cycle)   

CNG :( 100m to go need time)  Motor cycle :( 100m to go need time)  

CNG-1= 7 sec Motor cycle-1= 5 sec 

CNG-2= 5 sec Motor cycle-2= 4 sec 

CNG-3= 4 sec Motor cycle-3= 6 sec 

Avg= 5 sec Avg= 5 sec                                        

    

  Avg. time= (5+5)/2=5 sec   
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Category-1(Bus,Private car, Covered van)

Average= 6 sec

Speed= 64 kmph

Convert= 39 mph

Link-3 for category-1

1 Roadway pattern= 3 Lane two way

2 Lane width= 12  feet

3 Shoulder condition= 1  feet

4 Operating speed= 39 mph

5 %Passing sight distance= 13.56 ft

6 Level of service= d

Solution :

2320 veh/hr

1

0.78

1810 passenger(veh/hr)

Capacity of 3 Lane 2 way=

Capcity reduction factor for 9 feet width=

Capcity reduction for 1 feet shoulder=

Therefore actual roadway capacity=
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Category-2(CNG, Motor-Cycle)

Average= 5 sec

Speed= 70 kmph

Convert= 43 mph

Link-3 for category-2

1 Roadway pattern= 3 lane two way

2
Lane width= 12  feet

3 Shoulder condition= 0.78  feet

4 Operating speed= 39 mph

5 %passing sight distance= 13.56 ft

6 level of service= d

Solution :

3240 veh/hr

1

Capcity reduction for 1 feet shoulder= 0.78

Therefore actual roadway capacity= 2527 Passenger(veh/hr)

Capacity of 3 Lane 2 way=

Capcity reduction factor for 9 feet width=
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4.3 Saturation flow: 

 

Our links we collected 6 sec interval PCU saturation flow then we converted hourly PCU 

saturation flow for up and down direction also peak hour and off peak hour for three days 

(Monday, Wednesday and Thursday). 

 

Date: 14/11/2019 Thursday  

Link 

Name 
Direction Time 

Saturation flow 

(PCU/6 sec) 

Saturation flow 

(PCU/hr.) 

Link-1 

Up Peak Hour 11.01 6606 

Up Off Peak Hour 8.09 4854 

Down Peak Hour 12.39 7434 

Down Off Peak Hour 7.48 4488 

Link-2 

Up Peak Hour 13 7800 

Up Off Peak Hour 7.87 4722 

Down Peak Hour 11.38 6828 

Down Off Peak Hour 8.07 4842 

Link-3 

Up Peak Hour 11.72 7032 

Up Off Peak Hour 8.23 4938 

Down Peak Hour 12.85 7710 

Down Off Peak Hour 7.7 4620 

 

 

 

Table: 4.2 Saturation flow for Thursday (Link-1, Link-2, Link-3) 
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Table: 4.3 Saturation flow for Monday (Link-1, Link-2, Link-3) 

 

Date: 20/11/2019 Wednesday   

Link Name Direction Time 
Saturation flow 

(PCU/6 sec) 

Saturation flow 

(PCU/hr.) 

Link-1 

Up Peak Hour 10.56 6336 

Up Off Peak Hour 8.59 5154 

Down Peak Hour 12.39 7434 

Down Off Peak Hour 9.47 5682 

Link-2 

Up Peak Hour 11.72 7032 

Up Off Peak Hour 8.44 5064 

Down Peak Hour 11.38 6828 

Down Off Peak Hour 8.69 5214 

Link-3 

Up Peak Hour 13 7800 

Up Off Peak Hour 8.19 4914 

Down Peak Hour 12.84 7704 

Down Off Peak Hour 8.72 5232 

 

 

Table: 4.4 Saturation flow for Wednesday (Link-1, Link-2, Link-3) 

 

Date: 18/11/2019 Monday   

Link Name Direction Time 
Saturation flow 

(PCU/6 sec) 

Saturation flow 

(PCU/hr.) 

Link-1 

Up Peak Hour 10.99 6594 

Up Off Peak Hour 8.74 5244 

Down Peak Hour 10.1 6060 

Down Off Peak Hour 8.19 4914 

Link-2 

Up Peak Hour 10.53 6318 

Up Off Peak Hour 8.81 5286 

Down Peak Hour 9.98 5988 

Down Off Peak Hour 8.35 5010 

Link-3 

Up Peak Hour 9.02 5412 

Up Off Peak Hour 8.74 5244 

Down Peak Hour 10.28 6168 

Down Off Peak Hour 8.19 4914 
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4.4 Compare between roadway capacity and saturation flow: 

For our selected links we compare between total roadway capacity and saturation flow we 

saw that roadway capacity PCU/hr. is lower than saturation flow PCU/hr. So this link is 

saturated. 

 

Date: 14/11/2019 Thursday  

Link  Direction Time 

Total 

Roadway 

Capacity 

(PCU/hr.) 

Saturation 

flow (PCU/6 

sec) 

Saturation 

flow 

(PCU/hr.) 

Link -1 

Up Peak Hour 2022 11.01 6606 

Up Off Peak Hour 2022 8.09 4854 

Down Peak Hour 2022 12.39 7434 

Down Off Peak Hour 2022 7.48 4488 

Link -2 

Up Peak Hour 1731 13 7800 

Up Off Peak Hour 1731 7.87 4722 

Down Peak Hour 1731 11.38 6828 

Down Off Peak Hour 1731 8.07 4842 

Link -3 

Up Peak Hour 2169 11.72 7032 

Up Off Peak Hour 2169 8.23 4938 

Down Peak Hour 2169 12.85 7710 

Down Off Peak Hour 2169 7.7 4620 

 

 

Table: 4.5 Compare between roadway capacity and saturation flow 14/11/2019 Thursday 
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Fig: 4.4 Roadway Capacity vs. Saturation flow comparison bar chart on 14/11/19(Thursday) 

 

We see from roadway capacity and saturation flow comparison bar chart on Thursday link-1 

peak hour and off peak hour of up & down direction saturation flow is higher than roadway 

capacity. We see here link-2 & link-3 condition are similar to link-1. So link-1, link-2 & link-

3 are saturated and congested. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2022 2022 2022 2022 1731 1731 1731 1731 
2169 2169 2169 2169 

6606 

4854 

7434 

4488 

7800 

4722 

6828 

4842 

7032 

4938 

7710 

4620 

Peak

Hour

Off

Peak

Hour

Peak

Hour

Off

Peak

Hour

Peak

Hour

Off

Peak

Hour

Peak

Hour

Off

Peak

Hour

Peak

Hour

Off

Peak

Hour

Peak

Hour

Off

Peak

Hour

Up Up Down Down Up Up Down Down Up Up Down Down

Link-1 Link-2 Link-3

Roadway Capacity Vs Saturation flow comparison 14/11/19(Thursday) 

Total Roadway Capacity (PCU/hr) Saturation flow (PCU/hr)
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Date: 18/11/2019 Monday   

Link  

Direction Time 

Total Roadway 

Capacity 

(PCU/hr.) 

Saturation flow 

(PCU/6 sec) 

Saturation flow 

(PCU/hr.) 

Link -1 

 

Up Peak Hour 2022 10.99 6594 

Up 
Off Peak 

Hour 
2022 8.74 5244 

Down Peak Hour 2022 10.1 6060 

Down 
Off Peak 

Hour 
2022 8.19 4914 

Link -2 

 

Up Peak Hour 1731 10.53 6318 

Up 
Off Peak 

Hour 
1731 8.81 5286 

Down Peak Hour 1731 9.98 5988 

Down 
Off Peak 

Hour 
1731 8.35 5010 

Link -3 Up Peak Hour 2169 9.02 5412 

Up 
Off Peak 

Hour 
2169 8.74 5244 

Down Peak Hour 2169 10.28 6168 

Down 
Off Peak 

Hour 
2169 8.19 4914 

 

Table: 4.6 Compare between roadway capacity and saturation flow 18/11/2019 Monday 
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Fig: 4.5 Roadway Capacity vs. Saturation flow comparison bar chart on 18/11/19(Monday) 

 

We see from roadway capacity and saturation flow comparison bar chart on Monday link-1 

peak hour and off peak hour of up & down direction saturation flow is higher than roadway 

capacity. We see here link-2 & link-3 condition are similar to link-1. So link-1, link-2 & link-

3 are saturated and congested. 
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Roadway Capacity Vs Saturation flow comparison 18/11/19(Monday) 

Total Roadway Capacity (PCU/hr) Saturation flow (PCU/hr)
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Date: 20/11/2019 Wednesday   

Link  

Direction Time 

Total Roadway 

Capacity 

(PCU/hr.) 

Saturation flow 

(PCU/6 sec) 

Saturation flow 

(PCU/hr.) 

Link -1 

 

Up Peak Hour 2022 10.56 6336 

Up 
Off Peak 

Hour 
2022 8.59 5154 

Down Peak Hour 2022 12.39 7434 

Down 
Off Peak 

Hour 
2022 9.47 5682 

Link -2 

 

Up Peak Hour 1731 11.72 7032 

Up 
Off Peak 

Hour 
1731 8.44 5064 

Down Peak Hour 1731 11.38 6828 

Down 
Off Peak 

Hour 
1731 8.69 5214 

Link -3 Up Peak Hour 2169 13 7800 

Up 
Off Peak 

Hour 
2169 8.19 4914 

Down Peak Hour 2169 12.84 7704 

Down 
Off Peak 

Hour 
2169 8.72 5232 

 

Table: 4.7 Compare between roadway capacity and saturation flow 20/11/2019 Wednesday 
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Fig: 4.6 Roadway Capacity vs. Saturation flow comparison bar chart on 

20/11/19(Wednesday) 

 

We see from roadway capacity and saturation flow comparison bar chart on Wednesday link-

1 peak hour and off peak hour of up & down direction saturation flow is higher than roadway 

capacity. We see here link-2 & link-3 condition are similar to link-1. So link-1, link-2 & link-

3 are saturated and congested. 
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CHAPTER 5 

RESULT AND DISCUSSION 

 
5.1 Result: 

 

After inputting the day wise hourly PCU/Lane data and roadway capacity and saturation flow 

per lane through the ArcGIS application for each link and intersection, the time slider shows 

us different color line above the link and intersection relative to the PCU/Lane and roadway 

capacity. Hourly PCU is in how many vehicle moves on the road. Then we could understand 

about what is roadway condition is it saturated or not. 

 

5.1.1 Hourly PCU:  

 

 

Name Color  PCU Range Type 

Green   1517-1600 Free flow 

Light green   1608.5-2050 Stable 

Cyan   2064.5-2600 Approaching unstable flow 

Orange   2603.25-3050 Approaching unstable flow 

Red   3100.25-3300 Unstable flow 

Maroon   3308.5-3500 Forced flow 

 

 

Fig: 5.1 Color variation and PCU range 
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Fig: 5.2 Hourly PCU/lane time slider 

 
 

 

Fig: 5.3 Hourly PCU/Lane variations from 30-sep-19 10:00 AM to 04-oct-19 10:00 AM 

 

From 30/09/2019 to 04/10/2019 based on these five-day PCU data, from the color line we can see that 

the value of this five-day PCU from Dhanmondi-32 to Dhanmondi-27 was from the range 3308.5 to 

3500 and maroon color it is forced flow. On the other hand, PCU from Dhanmondi-27 to Kalabagan 

was from range 1517 to 1600 and green color it is free flow. 

 

Manik Mia Ave. 

Dhanmondi-27 

Shukrabad 

Dhanmondi-32 

Manik Mia Ave. 

Shukrabad 

Dhanmondi-27 

Dhanmondi-32 
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Fig: 5.4 Hourly PCU/Lane variations from 12-oct-19 10:00 AM to 16-oct-19 10:00 AM 

From 12/10/2019 to 16/10/2019 based on these five-day PCU data, from the color line we can see that 

the value of this five-day PCU from Dhanmondi-32 to Dhanmondi-27 was from the range 1517 to 

1600 and green color it is free flow. On the other hand, PCU from Dhanmondi-27 to Shukrabad was 

from range 3308.50 to 3500 and maroon color it is forced flow. 

 

 
Fig: 5.5 Hourly PCU/Lane variations from 05-Nov-19 10:00 AM to 09-Nov-19 10:00 AM 

Manik Mia Ave. 

Dhanmondi-27 

Shukrabad 

Dhanmondi-32 

Manik Mia Ave. 

Dhanmondi-27 

Shukrabad 

Dhanmondi-32 
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From 05/11/2019 to 09/11/2019 based on these five-day PCU data, from the color line we can see that 

the value of this five-day PCU from Dhanmondi-27 to Ashadgate was from the range 2603.25 to 

3050 and orange color it is approaching unstable flow. On the other hand, PCU from Manik mia to 

Dhanmondi-27 was from range 1608.50 to 2050 and light green color it is stable flow. 

 

 

5.1.2 Roadway Capacity and Saturation flow: 

 

Color variation for Roadway capacity and saturation flow 

 

 

Color  Name 

  Roadway capacity 

  Saturation flow 
 

Fig: 5.6 Color variations for Roadway capacity and saturation flow 

 

 

Fig: 5.7 Comparison between roadway capacity and saturation flow from 30-Sep-19 10:00 AM to 04-

Oct-19 10:00 AM 

Manik Mia Ave. 

Dhanmondi-32 

Dhanmondi-27 

Shukrabad 
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From 30-Sep-19 10:00 AM to 04-Oct-19 10:00 AM based on these five-day Roadway capacity and 

saturation flow data from the color flow chart we can see that saturation flow was higher than 

roadway capacity for Manik mia to Dhanmondi-27, Dhanmondi-27 to Shukrabad, Shukrabad to 

Dhanmondi-32. On the other hand Dhanmondi-32 to Dhanmondi-27 we can see that saturation flow 

was higher than roadway capacity. So the road was congested. 

 

 
 

Fig: 5.8 Comparison between roadway capacity and saturation flow from 06-Oct-19 10:00 AM to 10-

Oct-19 10:00 AM 

 

From 06-Oct-19 10:00 AM to 10-Oct-19 10:00 AM based on these five-day Roadway capacity and 

saturation flow data from the color flow chart we can see that saturation flow was higher than 

roadway capacity for Dhanmondi-27 to Shukrabad. On the other hand Dhanmondi-32 to Dhanmondi-

27 we can see that saturation flow was higher than roadway capacity. So the road was congested. 

 

Manik Mia Ave. 

Dhanmondi-32 

Shukrabad 

Dhanmondi-27 
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Fig: 5.9 Comparison between roadway capacity and saturation flow from 02-Nov-19 10:00 AM to 

06-Nov-19 10:00 AM 

 

From 02-Nov-19 10:00 AM to 06-Nov-19 10:00 AM based on these five-day Roadway capacity and 

saturation flow data from the color flow chart we can see that saturation flow was higher than 

roadway capacity for Mnik mia  to Shukrabad. On the other hand Dhanmondi-27 to Manik mia we 

can see that saturation flow was higher than roadway capacity. So the road was congested. 

 

 

 

5.1.3 Video Simulation link: 

 

1. Hourly PCU: https://www.youtube.com/watch?v=8VBsbtUIpTU 

 

2. Roadway capacity and Saturation flow: 

https://www.youtube.com/watch?v=vjP9jgrJ464 

 

 

 

 

 

 

Manik Mia Ave. 

Dhanmondi-27 

Shukrabad 

Dhanmondi-32 
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CHAPTER 6 

CONCLUSION 

 

Conclusion: 

We worked with 3 links and 4 intersections and presented traffic conditions and comparison 

between roadway capacity and saturation flow in the video simulation. It was very difficult to 

deal with just 3 links and 4 intersection data to replicate the real scenario. If there were more 

links and intersections working together instead of 3 links and 4 intersections, would be a lot 

of benefit to understanding an actual traffic conditions and compared between roadway 

capacity and saturation flow yet time constraints bound us to do. Moreover, we were not able 

to collect traffic data and saturation flow at the same time at each link and intersection during 

the data collection, resulting in gaps in the simulation. We considered 5 types of vehicles 

while collecting traffic volumes and saturation flow.  We considered 2 categories vehicle for 

determined roadway capacity. We believe that the representation could have been much 

better with larger amount of data in terms of duration, variations in the vehicle types and 

category in the vehicle types. However, this thesis output would provide a good platform to 

introduce the method of representation. 

Based on the results, we found similarities in the traffic congestion situation and road are 

saturated with the traffic count distributions for different links and intersections over the 

period of the study. This might be a result of PCU, roadway capacity and saturation flow 

consideration and as well. However, the method that was demonstrated in this thesis could be 

a decent start of resourceful research projects. 

In the future, the study of other data‟s and steps can be included for better portraying of the 

congestion situation. The data volume can be increased in terms of number of days and 

vehicle types for more accurate representation. Our thesis will help a lot of in determining 

much PCU each link and intersection, determining roadway capacity and saturation flow each 

link and intersection has for automation traffic signaling. This can lead to the application of 

modern concepts i.e. cooperative greens for achieve the most efficient method of traffic 

management for sustainable development of Dhaka city. 
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Appendices 

 

Data of heterogeneous traffic: 

 

Link-1: Dhanmondi-32 to Shukrabad 

UP 

Date    Bus Covered Van Private car CNG Motor-cycle 

    (1hr) PCU (1hr) PCU (1hr) PCU (1hr) PCU (1hr) PCU 

16-09-2019 

(Monday) 
Peak 145 435 37 74 791 791 275 206 312 156 

  
Off-

Peak 
155 465 47 94 969 969 182 137 545 273 

  Peak 184 552 39 78 1127 1127 288 216 737 369 

18-09-2019 

(Wednesday) 
Peak 155 465 42 84 798 798 248 186 301 151 

  
Off-

Peak 
135 405 66 132 1103 1103 278 209 329 165 

  Peak 183 549 53 106 1257 1257 232 174 385 193 

19-09-19 

(Thursday) 
Peak 132 396 39 78 989 989 305 229 295 148 

  
Off-

Peak 
195 585 89 178 1169 1169 401 301 752 376 

  Peak 225 675 91 182 1726 1726 295 221 1055 528 

23-09-2019 

(Monday 
Peak 149 447 36 72 797 797 182 137 312 156 

  
Off-

Peak 
158 474 43 86 956 956 256 192 525 263 

  Peak 188 564 32 64 1096 1096 245 184 712 356 

25-09-2019 

(Wednesday) 
Peak 157 471 41 82 788 788 236 177 328 164 

  
Off-

Peak 
137 411 51 102 1124 1124 285 214 357 179 

  Peak 189 567 39 78 1212 1212 228 171 372 186 

26-09-2019 

(Thursday) 
Peak 162 486 89 178 1011 1011 301 226 298 149 

  
Off-

Peak 
196 588 90 180 1189 1189 389 292 742 371 

  Peak 216 648 86 172 1801 1801 363 272 1054 527 

30-09-2019 

(Monday) 
Peak 121 363 33 66 723 723 288 216 298 149 

  
Off-

Peak 
147 441 41 82 895 895 176 132 514 257 

  Peak 163 489 30 60 1072 1072 295 221 696 348 

 

                 Table: 1 Dhanmondi-32 to Shukrabad (up) 7 Days 1 hr. and PCU/hr. data 
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DOWN 

Date    Bus 
Covered 

Van 
Private car CNG Motor-cycle 

    (1hr) PCU (1hr) PCU (1hr) PCU (1hr) PCU (1hr) PCU 

16-09-2019 

(Monday) 
Peak 220 660 31 62 1350 1350 388 291 1016 508 

  Off-Peak 142 426 69 138 975 975 248 186 255 128 

  Peak 146 438 50 100 1061 1061 320 240 380 190 

18-09-2019 

(Wednesday) 
Peak 241 723 67 134 1478 1478 279 209 1119 560 

  Off-Peak 103 309 93 186 960 960 392 294 509 255 

  Peak 102 306 37 74 1011 1011 277 208 271 136 

19-09-19 

(Thursday) 
Peak 260 780 71 142 1665 1665 413 310 1101 551 

  Off-Peak 116 348 43 86 1088 1088 296 222 448 224 

  Peak 164 492 55 110 1506 1506 358 269 661 331 

23-09-2019 

(Monday 
Peak 222 666 46 92 1526 1526 414 311 1015 508 

  Off-Peak 135 405 60 120 916 916 244 183 254 127 

  Peak 143 429 62 124 1038 1038 316 237 377 189 

25-09-2019 

(Wednesday) 
Peak 238 714 38 76 1426 1426 277 208 1115 558 

  Off-Peak 101 303 130 260 936 936 383 287 508 254 

  Peak 104 312 85 170 1029 1029 272 204 269 135 

26-09-2019 

(Thursday) 
Peak 266 798 75 150 1688 1688 407 305 1101 551 

  Off-Peak 123 369 70 140 1067 1067 293 220 447 224 

  Peak 171 513 85 170 1598 1598 353 265 665 333 

30-09-2019 

(Monday) 
Peak 232 696 45 90 1312 1312 375 281 1007 504 

  Off-Peak 105 315 61 122 936 936 240 180 281 141 

  Peak 141 423 65 130 1049 1049 313 235 362 181 

 

Table: 2 Dhanmondi-32 to Shukrabad (Down) 7 Days 1 hr. and PCU/hr. data 
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Link-2: Shukrabad to Dhanmondi-27 

 

UP 

Date   Bus Covered Van Private car CNG Motor-cycle 

    (1hr) PCU (1hr) PCU (1hr) PCU (1hr) PCU (1hr) PCU 

2/10/2019 

(Wednesday) 
Peak 175 525 28 56 778 778 237 178 321 161 

  Off-peak 131 393 43 86 1096 1096 269 202 335 168 

  Peak 178 534 33 66 1195 1195 227 170 377 189 

3/10/2019 

(Thursday) 
Peak 185 555 36 72 986 986 309 232 302 151 

  Off-peak 186 558 71 142 1126 1126 415 311 781 391 

  Peak 231 693 86 172 1776 1776 293 220 1075 538 

9/10/2019 

(Wednesday) 
Peak 163 489 46 92 772 772 231 173 337 169 

  Off-peak 141 423 49 98 1136 1136 286 215 386 193 

  Peak 187 561 37 74 1224 1224 233 175 355 178 

10/10/2019 

(Thursday) 
Peak 178 534 88 176 1101 1101 321 241 327 164 

  Off-peak 196 588 86 172 1191 1191 396 297 751 376 

  Peak 223 669 76 152 1876 1876 366 275 1072 536 

14/10/2019 

(Monday) 
Peak 121 363 36 72 732 732 277 208 296 148 

  Off-peak 143 429 41 82 876 876 165 124 514 257 

  Peak 171 513 33 66 1063 1063 294 221 626 313 

16/10/2019 

(Wednesday) 
Peak 152 456 31 62 798 798 249 187 311 156 

  Off-peak 143 429 54 108 1125 1125 297 223 377 189 

  Peak 193 579 39 78 1301 1301 246 185 336 168 

17/10/2019 

(Thursday) 
Peak 182 546 87 174 996 996 295 221 302 151 

  Off-peak 191 573 93 186 1277 1277 241 181 827 414 

  Peak 238 714 79 158 1802 1802 281 211 1126 563 

 

Table: 3 Shukrabad to Dhanmondi-27 (up) 7 days 1hr and PCU/hr. data 
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DOWN 

Date   Bus 
Covered 

Van 
Private car CNG Motor-cycle 

    (1hr) PCU (1hr) PCU (1hr) PCU (1hr) PCU (1hr) PCU 

2/10/2019 

(Wednesday) 
Peak 227 681 31 62 1350 1350 315 236 1001 501 

  Off-peak 145 435 69 138 975 975 245 184 509 255 

  Peak 147 441 50 100 1061 1061 320 240 270 135 

3/10/2019 

(Thursday) 
Peak 247 741 67 134 1478 1478 375 281 1101 551 

  Off-peak 103 309 92 184 960 960 282 212 396 198 

  Peak 101 303 37 74 1011 1011 425 319 675 338 

9/10/2019 

(Wednesday) 
Peak 260 780 71 142 1665 1665 296 222 1010 505 

  Off-peak 115 345 42 84 1085 1085 375 281 252 126 

  Peak 160 480 55 110 1506 1506 425 319 377 189 

10/10/2019 

(Thursday) 
Peak 275 825 46 92 1525 1525 412 309 1115 558 

  Off-peak 135 405 58 116 916 916 275 206 508 254 

  Peak 142 426 59 118 1035 1035 302 227 270 135 

14/10/2019 

(Monday) 
Peak 240 720 36 72 1425 1425 305 229 1103 552 

  Off-peak 101 303 130 260 935 935 240 180 280 140 

  Peak 104 312 85 170 1025 1025 315 236 362 181 

16/10/2019 

(Wednesday) 
Peak 260 780 75 150 1695 1695 385 289 1016 508 

  Off-peak 125 375 70 140 1075 1075 280 210 560 280 

  Peak 170 510 85 170 1596 1596 275 206 320 160 

17/10/2019 

(Thursday) 
Peak 280 840 44 88 1510 1510 420 315 1114 557 

  Off-peak 105 315 56 112 950 950 295 221 420 210 

  Peak 141 423 65 130 1044 1044 365 274 675 338 

 

Table: 4 Shukrabad to Dhanmondi-27 (down) 7 days 1hr and PCU/hr. data 
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Link- 3 Dhanmondi-27 to Manik mia Ave. 

 

 

UP 

Date   Bus Covered Van Private car CNG Motor-cycle 

    (1hr) PCU (1hr) PCU (1hr) PCU (1hr) PCU (1hr) PCU 

21/10/2019 

(Monday) 
Peak 137 411 32 64 828 828 301 226 309 155 

  Off-Peak 133 399 47 94 962 962 188 141 522 261 

  Peak 178 534 36 72 1125 1125 309 232 713 357 

23/10/2019  

(Wednesday) 
Peak 152 456 35 70 802 802 221 166 346 173 

  Off-Peak 181 543 56 112 1175 1175 277 208 398 199 

  Peak 188 564 39 78 1282 1282 241 181 401 201 

24/10/2019 

(Thursday) 
Peak 166 498 88 176 988 988 301 226 322 161 

  Off-Peak 171 513 91 182 1169 1169 426 320 802 401 

  Peak 289 867 73 146 1722 1722 333 250 1095 548 

28/10/2019 

(Monday) 
Peak 130 390 28 56 785 785 201 151 377 189 

  Off-Peak 144 432 36 72 958 958 287 215 487 244 

  Peak 171 513 31 62 1122 1122 295 221 574 287 

4/11/2019 

(Monday) 
Peak 165 495 33 66 756 756 244 183 356 178 

  Off-Peak 133 399 49 98 989 989 265 199 401 201 

  Peak 198 594 52 104 1056 1056 287 215 611 306 

6/11/2019 

(Wednesday) 
Peak 169 507 32 64 772 772 225 169 333 167 

  Off-Peak 145 435 44 88 1182 1182 257 193 378 189 

  Peak 177 531 37 74 1302 1302 298 224 415 208 

7/11/2019 

(Thursday) 
Peak 220 660 28 56 1226 1226 319 239 292 146 

  Off-Peak 188 564 78 156 1278 1278 405 304 877 439 

  Peak 271 813 66 132 1855 1855 249 187 1125 563 

 

Table: 5 Dhanmondi-27 to Manik mia (up) 7 days 1 hr. and PCU/hr. Data 
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DOWN 

Date   Bus Covered Van Private car CNG Motor-cycle 

    (1hr) PCU (1hr) PCU (1hr) PCU (1hr) PCU (1hr) PCU 

21/10/2019 

(Monday) 
Peak 178 534 37 74 1587 1587 415 311 1188 594 

  Off-Peak 112 336 135 270 997 997 287 215 277 139 

  Peak 119 357 85 170 1035 1035 325 244 382 191 

23/10/2019  

(Wednesday) 
Peak 210 630 77 154 1627 1627 387 290 1016 508 

  Off-Peak 127 381 72 144 1057 1057 292 219 582 291 

  Peak 186 558 87 174 1624 1624 263 197 422 211 

24/10/2019 

(Thursday) 
Peak 287 861 43 86 1582 1582 442 332 1175 588 

  Off-Peak 112 336 56 112 956 956 289 217 477 239 

  Peak 157 471 66 132 1096 1096 391 293 678 339 

28/10/2019 

(Monday) 
Peak 235 705 33 66 1337 1337 444 333 1023 512 

  Off-Peak 118 354 62 124 822 822 256 192 322 161 

  Peak 124 372 57 114 987 987 366 275 397 199 

4/11/2019 

(Monday) 
Peak 195 585 69 138 1301 1301 389 292 1139 570 

  Off-Peak 111 333 88 176 836 836 211 158 312 156 

  Peak 236 708 38 76 889 889 319 239 441 221 

6/11/2019 

(Wednesday) 
Peak 225 675 69 138 1675 1675 411 308 1095 548 

  Off-Peak 147 441 44 88 1125 1125 286 215 506 253 

  Peak 138 414 51 102 1403 1403 392 294 307 154 

7/11/2019 

(Thursday) 
Peak 252 756 43 86 1225 1225 277 208 1201 601 

  Off-Peak 117 351 57 114 1325 1325 254 191 369 185 

  Peak 145 435 49 98 1241 1241 433 325 723 362 

 

Table: 6 Dhanmondi-27 to Manik mia (down) 7 days 1 hr. and PCU/hr. Data 
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Data of Roadway capacity for different links: 

 

 

 

    

Link-1  

Dhanmoni-32 to Shukrabad  

SL. NO DOWN UP 
Unit 

1 28 37 ft. 

2 32 50 ft. 

3 35 47 ft. 

Lowest Width 28 37 ft. 

Shoulder condition 1 1 ft. 

Lane type 3 lane 2 way 

Width 28 ft. 

Lane width 9 ft. 

  

Table: 7 Link-1 roadway capacity measurement data and Total Roadway capacity 

 

Link-2 

    

Shukrabad to Dhanmondi-27 

 

Total Roadway capacity 

for two way Link-2 

Total 

Passenger 

(veh/hr.) 

SL. NO DOWN UP Unit 

 Category -

1  

Bus 

3462 

1 31 51 ft. 

 

Private car 

2 27 28 ft. 

 

Covered 

van 

3 50 41 ft. 

 
Category - 

2 

CNG 

Lowest Width 27 28 ft. 

 

Motor-

cycle 

Shoulder 

condition 
1 1 ft. 

    Lane type 3 lane 2 way 

    Width 27 ft. 

    Lane width 9 ft. 
    Table: 8 Link-2 Roadway capacity measurement data and Total Roadway capacity 

Total Roadway capacity for 

two way Link-1 

Total Passenger 

(veh/hr.) 

Category -1  

Bus 

4044 

Private car 

Covered van 

Category - 2 
CNG 

Motor-cycle 
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Total Roadway capacity for 

two way Link-3 

Total Passenger 

(veh/hr.) 

Category -1  

Bus 

4337 

Private car 

Covered van 

Category - 

2 

CNG 

Motor-cycle 

 

 

 

 

Table: 9 Link-3 Roadway capacity measurement data and total roadway capacity 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Link-3 

Dhanmondi -27 to Manik Mia 

SL. NO DOWN UP Unit 

1 37 51 ft. 

2 37 38 ft. 

3 50 38 ft. 

Lowest Width 37 38 ft. 

Shoulder condition 1 1 ft. 

Lane type 3 lane 2 way 

Width 37 ft. 

`Lane width 12 ft. 
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Data of Saturation flow for particular links: 

 

Peak hour data’s: 

 

 
 

Table: 10 Saturation flow Dhanmondi-32 (up) intersection Thursday peak hour data 

 
 

Table: 11 Saturation flow Shukrabad (down) intersection Thursday peak hour data 
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Table: 12 Saturation flow Shukrabad (Up) intersection Thursday peak hour data 

 
Table: 13 Saturation flow dhanmondi-27 (down) intersection Thursday peak hour data 
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Table: 14 Saturation flow Dhanmondi-27 (up) intersection Thursday peak hour data 

 
Table: 15 Saturation flow Manik mia (down) intersection Thursday peak hour data 
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Table: 16 Saturation flow Dhanmondi-32 (up) intersection Monday peak hour data 

 

 

Table: 17 Saturation flow Shukrabad (down) intersection Monday peak hour data  
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Table: 18 Saturation flow Shukrabad (up) intersection Monday peak hour data 

 

Table: 19 Saturation flow Dhanmondi-27 (down) intersection Monday peak hour data 
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 Table: 20 Saturation flow Dhanmondi-27 (up) intersection Monday peak hour data 

 

Table: 21 Saturation flow Manik mia (down) intersection Monday peak hour data 
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Table: 22 Saturation flow Dhanmondi-32 (down) intersection Wednesday peak hour data 

 

Table: 23 Saturation flow Dhanmondi-32 (up) intersection Wednesday peak hour data 
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Table: 24 Saturation flow Shukarabad (down) intersection Wednesday peak hour data 

 

Table: 25 Saturation flow Shukarabad (up) intersection Wednesday peak hour data 
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Table: 26 Saturation flow Dhanmondi-27 (down) intersection Wednesday peak hour data 

 

Table: 27 Saturation flow Dhanmondi-27 (up) intersection Wednesday peak hour data 
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 Table: 28 Saturation flow Manik mia  (down) intersection Wednesday peak hour data  

Off-peak hour data’s: 

 

 
 

Table: 29 Saturation flow dhanmondi-32 (up) intersection Thursday off peak hour data 
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Table: 30 Saturation flow Shukrabad (Up) intersection Thursday off peak hour data 

 

Table: 31 Saturation flow Shukrabad (down) intersection Thursday off peak hour data 
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Table: 32 Saturation flow dhanmondi-27 (up) intersection Thursday off peak hour data 

 

 
Table: 33 Saturation flow dhanmondi-27 (down) intersection Thursday off peak hour data 
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Table: 34 Saturation flow Manik mia (down) intersection Thursday off peak hour data 

Table: 35 Saturation flow Dhanmondi-32 (up) intersection Monday off peak hour data 
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Table: 36 Saturation flow Shukrabad (up) intersection Monday off peak hour data 

 

Table: 37 Saturation flow Shukrabad (down) intersection Monday off peak hour data 
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Table: 38 Saturation flow Dhanmondi-27 (up) intersection Monday off peak hour data 

 

 
Table: 39 Saturation flow Dhanmondi-27 (down) intersection Monday off peak hour data 
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Table: 40 Saturation flow Manik mia (down) intersection Monday off peak hour data 

 

Table: 41 Saturation flow Dhanmondi-32 (up) intersection Wednesday off peak hour data 
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Table: 42 Saturation flow Shukarabad (up) intersection Wednesday off peak hour data 

 

 
      Table: 43 Saturation flow Shukarabad (down) intersection Wednesday off peak hour data 
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     Table: 44 Saturation flow Dhanmondi-27 (up) intersection Wednesday off peak hour data 

 

 
     Table: 45 Saturation flow Dhanmondi-27 (down) intersection Wednesday off peak hour data 
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Table: 46 Saturation flow Manik mia (down) intersection Wednesday off peak hour data 
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